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I"PARTIE : TOURNE-DISQUE USB
CONSIGNESDE SECURITE IMPORTANTESRELATIVEMENT AUX PRODUITSAUDIO.
PRIERE DE LESLIRE AU COMPLET.

Lorsgu’ on utilise des appareils électriques, on doit toujours observer des régles éémentaires de
Sécurité, notamment.

1l.Lirelemoded emploi — Lisez toutes les consignes relatives ala sécurité et al’emploi du
produit avant de le faire fonctionner.

2. Conserver le mode d’emploi — Conservez les notices de sécurité et d’emploi du produit afin
de pouvoir les consulter al’avenir.

3. Tenez compte le mode d’emploi- Tous |es avertissements sur le produit et dansles
instructions de fonctionnement doivent étre respectées

4. Observez |les consignes —Observez tous les avertissements qui figurent sur e produit et dans
le mode d’emploi.

5.Observez le mode d’ emploi —Observez toutes |es directives quant al’emploi de |’ appareil.

6. Nettoyage — Débranchez ce rprod_u_it delaprise de courant avant de le nettoyer. N’ utilisez aucun
nettoyant liquide ou en aérosol. Utilisez un chiffon humide pour nettoyer I’ appareil.

7.Equipement connexe — N’ attachez |’ appareil & aucun équipement qui ne soit pas expressément
recommandé par le fabricant du produit, car cela peut poser un risgue.

8. Eau et humidité— N'utilisez pas ce produit a proximité d' eau (par exemple : prés d'une
baignoire, d'un bac de lavage, d' un évier de cuisine ou de buanderie, dans un sous-sol humide, a
proximité d’ une piscine, etc.)

9. Accessoires— Ne posez pas cet appareil sur une surface instable. L’ appareil risque de tomber et
de blesser grievement un enfant ou un adulte ; il risque également de s abimer sérieusement.
Ultilisez uniquement un pied, un support ou une table recommandés par |e fabricant ou vendus
avec le produit. Toute fixation du produit doit adhérer aux directives du fabricant et doit faire
appel a un support de fixation recommandé par le fabricant.

10. Transport — Ce produit doit étre déplacé avec le plus grand soin pour

éviter de provoquer des blessures ou des dégéats matériels quel conques.

11. Alimentation — Cet appareil doit uniquement étre branché sur une source

d’ énergie conforme aux indications de I’ étiquette signalétique. Si vous avez le

moindre doute quant al’installation électrique qui existe chez vous, consultez le

distributeur qui vous avendu I’ appareil ou lasociété locale de distribution de

I'électricité. Pour ce qui est des produits congus pour fonctionner avec des piles ou —ﬁp_

d'autres sources d’ énergie, consultez le mode d’ emploi.

12. Lapriseprincipale - Laprise principale est utilisée comme dispositif de déconnexion, le
dispositif de déconnexion doit rester facilement accessible.




13. Protection du cordon d’alimentation — Les cordons d’ alimentation doivent étre acheminés
de maniére a éviter qu'ils soient coincés de quelque maniére que ce soit.

14. Foudr e — Pour mieux protéger ce produit pendant les orages ou lorsgu'’il est laissé sans
surveillance et sans qu’on I’ utilise pendant de longues périodes de temps, débranchez-le de la
prise de courant et débranchez-le de I’ antenne ou du céble. Cela éviteraque I’ appareil soit
endommageé par lafoudre ou par les surtensions.

15. Lignes éectriques — Ne placez jamais une antenne extérieure a proximité d’' une ligne
électrique ou d’un quelconque autre circuit éectrique ou d'éclairage, ou a un endroit ou |’ antenne
risque de tomber sur ces lignes ou circuits électriques. Lors de I’'install ation d’ une antenne
extérieure, évitez atout prix de heurter ces lignes ou circuits électriques, car le moindre contact
pourrait étre mortel.

16. Surchar ge — Ne surchargez pas les prises de courant, les rallonges ou les

prolongateurs, car cela risque de causer un incendie ou un choc électrique.

17. Exposition aux liquides et insertion d’objets — Ne jamais insérer un objet quelconque dans
les ouvertures de cet appareil, car |’ objet risque d’ atteindre une composante porteuse d' une
tension dangereuse ou de court-circuiter des piéces, de maniére a causer un incendie ou un choc
électrique. Ne jamais renverser un liquide quelconque sur le produit.

18. Réparation — N’ essayez pas de réparer ce produit vous-méme, car |’ ouverture ou le
démontage d’' un couvercle risgue de vous exposer a des tensions dangereuses ou a d’ autres
dangers. Confiez toute réparation a un technicien de réparation qualifié.

19. Dégats exigeant des répar ations — Débranchez cet appareil de la prise de courant et faites-le
réparer par un technicien qualifié dans les circonstances suivantes :

a. lafiche ou le cordon d' aimentation est abimé;

b. un liquide a été renversé sur |'appareil ou des objets se logent dans celui-ci;

c. le produit a éé exposé alapluie ou al’ eau;

d. le produit ne fonctionne pas convenablement lorsqu’ on observe le mode d’emploi ; réglez
uniquement les commandes qui sont indiquées dans le mode d’ emploi, car un mauvais

réglage d’ autres commandes risque d' abimer |’ appareil et d’ exiger d'importantes

réparations, que seul un technicien qualifié peut faire, afin de remettre I’ appareil en état de
fonctionner; ou

e. I'appareil a subi une chute ou des dommages quelcongues, et son fonctionnement s est
nettement détérioré, au point de rendre des réparations nécessaires.

20. Piéces de rechange — Si vous avez besoin de piéces de rechange, veillez ace quele
technicien utilise les piéces de rechange stipul ées par le fabricant ou ayant des

caractéristiques identiques a celles de la piéce originale. Toute substitution non autorisée risque
d’engendrer un incendie, un choc éectrique ou d' autres dangers.

21. Vérifications de sécurité — Aprés toute réparation ou révision de cet appareil, demandez au
technicien de réparation de vérifier quel’ appareil est en bon état de fonctionnement et qu’il ne
pose aucun risgue.

23. Chaleur — Le produit doit étre placé suffisamment loin de toute source de chaleur, comme les
radiateurs, les appareils de chauffage, lesfours, y compris les amplificateurs.



Précautions
Renseignements relatifs ala sécurité

ATTENTION!

1. Pour mettre cet appareil complétement hors tension, débranchez le cordon d’ alimentation de la
prise de courant. Veillez a débrancher I appareil si vous ne prévoyez pas de |’ utiliser pendant

une longue période de temps (EX. : pendant vos vacances).

2. L’emploi de commandes, de procédures ou de réglages qui ne sont pas indiqués aux

présentes peut entrainer une exposition & un niveau dangereux de radiation.

3. Si ce produit se met afonctionner défectueusement, communiquez avec un centre de service
qualifié et cessez d' utiliser le produit.

Consignes de sécurité

AVERTISSEMENT :

Pour réduire le risque d'incendie ou de choc éectrique, abstenez-vous d’ exposer cet appareil alapluie
ou al’humidité.

ATTENTION!
RISQUE DE CHOC ELECTRIQUE —NE PAS OUVRIR
Pour réduire le risque de choc éectrique, abstenez-vous d’ enlever le couvercle ou la partie arriére de
I’ appareil.
Aucune composante intérieure n’ est réparable par |’ utilisateur.
Confiez toute réparation a un technicien qualifié.

Le symbole de I’ éclair terminé par une fléche, al’intérieur d’un triangle équilatéral, vise a
signaler, aux utilisateurs, la présence d’ une « tension dangereuse » non isolée dans |’ enceinte
du produit, laquelle tension peut étre suffisante pour poser un risque de choc électrique pour
I’ é&tre humain.
n Le point d’ exclamation dans un triangle équilatéral vise asignaler, aux utilisateurs, la
présence de consignes importantes relativement al’ emploi et al’ entretien (ou ala
réparation), dans la documentation qui accompagne |’ appareil.

(Vair lesindications al’ arriére de I’ appareil.)

ATTENTION!
Pour éviter les chocs électriques, correspondez la lame large de la fiche dans la fente large,
insérez compl étement



Avant d’ utiliser I’appareil

1.Choisissez I’ emplacement de I’ appareil soigneusement. Evitez de I’ exposer directement aux
rayons du soleil ou de le poser prés d’ une source de chaleur. Evitez également les emplacements
excessivement poussiéreux ou assujettis ades vibrations, au froid ou al’ humidité. Tenez

I" appareil loin des sources de bourdonnements, comme |es transformateurs ou les moteurs.

2.N’ouvrez pas le boitier de I’ appareil, car vous pourriez abimer les circuits ou subir un choc
électrique. Si un corps étranger se loge dans |’ appareil, communiquez avec le distributeur qui
vous I'avendu.

3.Evitez de manier la pointe de lecture (aiguille) lorsque vous avez les doigts sales.
4.1 orsque vous débranchez lafiche de la prise de courant, tirez toujours directement sur lafiche;
netirez jamais sur le cordon.

5.N’essayez pas de nettoyer I’ appareil au moyen de solvants chimiques, car celarisque d’ en
abimer le fini. Utilisez un chiffon doux et propre.

6.Pour mettre cet appareil complétement hors tension, débranchez le cordon d’ adimentation de la
prise de courant. Veillez a débrancher I’ appareil si vous ne prévoyez pas del’ utiliser pendant
une longue période de temps (EX. : pendant vos vacances).

7.Conservez la présente notice dans un lieu sir.



Schéma

1. INTERRUPTEUR D’ALIMENTATION
2. VISDE TRANSPORT

3. BRASDE LECTURE

4. LEVIER DE REPERAGE

5. INTERRUPTEUR DE CONTROLE DE
VITESSE

6. APPUI DU BRAS DE LECTURE
7.BOUTON D’ARRET

8. BOUTON D’EJECTION

9. BOUTON DE LECTURE

10. TOURNE-DISQUE

11. FENTE USB

12. SORTIE LIGNE

13. CORDON D’ALIMENTATION CA

g

Temoin
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Préparation avant I’ utilisation

1. Branchez le cordon d’ alimentation CA sur une prise de courant alternatif

2. Lavis de transport protege e chassis phonographe pendant | e transportation. Avant 'utilisation,
utilisez une piéce ou un tournevis pour régler lavis de transport afin de laisser la plaque tournante
tourner librement. En cas de transportation, tourner lavis de transport pour fixer la plaque
tournante

Remplacement dela pointe delecture (aiguille)

Démontage de |I'ancienne pointe de lecture ‘,

1. Placez un tournevis au bout de la pointe de lecture et

poussez vers le bas, dansladirection « A ».

2. Enlevez la pointe de lecture en la tirant vers |’ avant (A
et versle bas.

Installation d’une nouvelle pointe de lecture
1. Tenez la pointe de lecture par le bout et insérez son

autre extrémité en appuyant dans ladirection « B ».
2. Poussez vers | e haut, dans la direction « C », jusgu’a t
ce que le bout de la pointe se verrouille en place ©

©

Broches de guidage (intérieures)



Lectured’un disque
1. Branchez le cordon d’ aimentation CA sur une prise de courant

2. Branchez les deux extrémités du céble de SORTIE LIGNE sur
I’entrée auxiliaire (Aux) de votre téléviseur, du récepteur de votre
chaine audiovisuele ou d’ une autre chaine audiophonique. Prenez
soin d'insérer e céble RCA rouge danslaprise rouge et le cable RCA
blanc dansla prise blanche.

3. Appuyez sur lebouton d ALIMENTATION devant de | apparelil.
Allumez également I’ appareil que vous avez connecté au tourne-disque.

4. Mettez un disque sur le tourne-disgue. Si vous jouez un disque 45 tours,
souvenez-vous d’ utiliser I’ adaptateur compris dans le sac en plastique
renfermé avec le manuel.

5. Choisissez lavitesse du tourne-disque (33, 45 ou 78 toursminute) en
fonction du disque que vous jouez.

6. Enlevez le crochet de I’ appui du bras de lecture, soulevez lelevier de
repérage et déplacez le bras ddlicatement jusqu’ al’ endroit voulu du disque.
Baissez doucement lelevier de repérage; le disque commenceraaors a
jouer.

7. Réglez le volume sur votre appareil connecté.

8. Appuyez sur le bouton d ARRET pour cesser dejouer le disque.

9. Appuyez sur le bouton de LECTURE pour reprendre lalecture du disque.

10. Lorsque lalecture du disque est terminée, le bras revient
automatiquement sur son appui et le témoin lumineux s allume. Ou
VOuUS pouvez appuyer sur le bouton d’ EJECTION pendant la lecture,
le bras de lecture se soulévera et reviendra automatiquement sur son
appui. Le bras de lecture prend environ 20 secondes pour revenir ason
appui lorsque I’ appareil joue un disque 78 tours.

11. Souvenez-vous de débrancher I’ appareil de la prise de courant lorsque

vous ne n’ utilisez pas pendant une longue période de temps.

sortie ligne
] [l ‘l
-
-
Prise USE p\

2

g
-

Indicator
Light
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[1°PARTIE : Logiciel Audacity

» ~

~ ©

1& I m;ludacily é.lf‘

Le CD compris contient leslogiciels suivants :

=

(1) audacity-src-1.2.6 ------------ Pour Windows
(2) Audacity_for_MAC --------- Pour Macintosh
(3) Audacity_for WIN ---------- Pour Windows

(4) AUTORUN.INF

(5) Licence GPL (dossier HTML)

Leslogiciels sont compatibles avec les systémes d’ exploitation Windows 98, 2000, ME, XP,
VISTA, 7 et Macintosh.

Installation d’ Audacity et connexion USB

Connectez une extrémité du cable USB alaplatine et I'autre extrémité sur votre ordinateur.
Ensuite, branchez le cordon d'alimentation CA de la platine. Puis appuyez sur I’ interrupteur
d'aimentation pour allumer le tourne-disgue.

1. Insérez le disque du logiciel Audacity livré avec votre appareil. Cliquez sur le disque Audacity
sur le bureau.

2. Ledisgue Audacity contient cing dossiers. Sélectionnez Audacity for MAC pour systéme
Macintosh et sélectionnez Audacity_for_WIN pour un systéme Windows.

ré O_O (%) Audacity =
2 _:: BEOT N ER Q
¥ Devices
:_! Macintosh HD

El ipisk
© Audacity a audacity-src-1.2.6 Audacity_for_MAC Audacity_for_WIN

|| Audacity 1.3.7.1 |

" Flaces -

» Search
AUTORUN.INF The CGNU General Public
License.html




Installation de logiciel Audacity

1. L’assistant d'ingtallation d’ Audacity s affiche. Cliquez sur Next (Suite) pour installer le
logiciel.

5 Setup - Audacity E| a ﬁ]

Welcome to the Audacity Setup
Wizard
This will install Audacity 1.2.6 on your computer.

It is recommended that you close all other applications before
continuing.

Chick Next to continue, or Cancel to exit Setup.

[ Nest > ][ Cancel

2. Cliquez sur « | accept the agreement » (Jaccepte le contrat), puis cliquez sur Next (Suite).

5 Setup - Audacity

License Agreement
Flease read the following important information before continuing.

Please read the following License Agreement. “You must accept the terms of this
agreement before continuing with the installation.

|Mote: Audacity is distributed under the terms of the GNU GPL. A
This inchudes everything in the source code distiibution

except code in the lib-sic directory. Code in the Bb-sie

tdirectory may be released under a different bcense

[which iz GPL-compatible). For a summary, see the

README txt file, and for specific details, see the license

information inside each subdwectony of lib-sic.

The full text of the GNU GPL follows:
GNU GENERAL PUBLIC LICENSE b

() | accept the agreement
(O 1 do not accept the agreement

|_ < Back ][ Nest » ]L Cancel J
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3. Continuez acliquer sur les boutons Next.

5! Setup - Audacity

Information
Please read the following important information before continuing.

‘When you are ready to continue with Setup, click Next.

kiudacity: A Free, Cross-Platform Digital Audio E ditor ~
Version 1.2.6
For changelog, see the bottom of this document.
Email audacity-help@lists. sourceforge.net
Lead Developers:
Dominic Mazzoni (project leader)
Malt Brubeck
James Crook
WYaughan Johnson v

[ < Back ]I Next > I[ Cancel ]

15 Setup - Audacity

Select Destination Location
‘Where should Audacity be installed?

,J Setup will install Audacity into the following folder.

To continue, click Next. If you would like to select a different folder, click Browse.

i | Browse... I

sgram Fil

At least 8.3 MB of free disk space is required.

[ <Back || MNew> | [ Cancel |

11



5] Setup - Audacity

Select Additional Tasks
‘Which additional tasks should be performed?

Select the additional tasks you would ke Setup to perform while instaling Audacity, then
click Next,

Additional icons:

Create a desktop icon

Other tasks:

Associate Audacity project files

[ <Back || mNew> | | cancel |

4. Cliquez sur le bouton « Install » (Installation) pour démarrer I’installation.

6! Setup - Audacity

Ready to Install
Setup is now ready to begin installing Audacity on your computer.

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

-D estination Focetién:
C:\Program Files\Audacity

Additional tasks:
Additional icons:
Create a desktop icon
Other tasks:
Associate Audacity project files

[ < Back H Install ][ Cancel j

12



16! Setup - Audacity

Installing
Please wait while Setup installs Audacity on your computer.

Extracting files...
C:\Program Files\Audacity\Languages\uk\Audacity. mo

Cancel

5. Cliquez sur « Finish » (Terminer) pour clore I’ installation.

i Setup - Audacity E“ =)

Completing the Audacity Setup
Wizard

Setup has finished installing Audacity on your computer. The
application may be launched by selecting the installed icons.

Click Finish to exit Setup.

Launch Audacity

6. Vous pouvez maintenant ouvrir le logiciel Audacity et commencer a enregistrer vos fichiers.
REMARQUE : Unefois que vous avez configuré Audacity, vous n’ avez pas besoin de
reconfigurer a chaque utilisation

(Pour plus d'amples renseignements, visitez le site Web d’ Audacity a
http://audacity.sourceforge.net)
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Configuration d’ Audacity pour Microsoft Windows

Interface d’ Audacity

Broject Gererste Effect dnshze e : - |
WPDYWE)?2) |Sgwaaspg waas
i (- T LB * [ stereo =]
[fa[@®]ea] o] A[p[2]2]
-10 o0 1.0 2.0

[
Projectrate: 44100 | [Cursor: 0100.000000 mincsec [Snap-To Of]

Interface d’ Audacity-- Réglages et commandes.
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Boutons de commande d’ Audacity

Utilisez les boutons de commande en haut de I’ écran pour aler au début du fichier, pour
jouer, enregistrer, faire une pause, arréter et terminer. Utilisez les menus File (Fichier), Edit
(Edition), View (Affichage), Project (Projet), Generate (Générer), Effect (Effet) et Anayze
(Analyse) pour sauvegarder, exporter et éditer les enregistrements de musique.

1. Cliquez sur le bouton @ pour aller au tout débui.

2. Réglage du volume du signal de sortie.

3. Cliquez sur le bouton @ pour jouer I’ enregistrement.

4. Cliquez sur le bouton @ pour enregistrer.

5. Cliquez sur le bouton@ pour faire une pause.

6. Cliquez sur le bouton @ pour arréter |’ enregistrement.

7. Réglage du volume du signal d’entrée

8. Cliquez sur le bouton @ pour dler alafin del’ enregistrement.

S W U A
T-Z"? I}? Xnerrz 9._ ;avT Heb \ / .

= " B M
EadhadR. -
G G )
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Pr éférences dans Audacity

1. Cliquez sur « Edit » (Edition) dans I’ interface audacity, puis sélectionnez « Preferences »
(Préférences).

Bleedtwewerobutgm«auzﬁe;tmueb

—an't Und Ctrl+Z
Can't Redo Chri+Y ‘.) J -) -)
Cut Ctrl+¥ -
.:I:II:II:I Ctri+-C '-—-—-—-—-—-—-—————-@ li
Paste Chrl+Y
el I

0 20

L’ écran de réglage des préférences d’ Audacity s ouvre alors. || comporte les onglets suivants :
«Audiol/O » (E/S audio), « Quality » (Qualité), « FileFormats » (Formats de fichier),

« Spectrograms » (Spectrogrammes), « Directories » (Répertoires), « Interface » (Interface),

« Keyboard » (Clavier) et « Mouse » (Souris).

Audacity Preferences

Audio /0 | Qualty File Formats | Spectiagrams | Directories | Interface | Keyboard | Mouse |

16



2. Sélectionnez le périphérique utilisé pour I’enregistrement, soit « microphone (USB Audio
CODEC) »
e Cliquez sur I’onglet « Audio I/O » (E/S audio) dans la fenétre des préférences d’ Audacity.
e Cliquez sur « Device » (Périphérique) dans le volet « Recording » (Enregistrement) et
sélectionnez « microphone (USB Audio CODEC) ».
e Cliquez sur « Channels » (Canaux) et sélectionnez « 2 (stéréo) ».
e Cliquez sur « OK ».
e Remarque: Si « microphone (USB Audio CODEC) » ne figure pas dans la liste de
périphériques, fermez le logiciel Audacity, puis lancez-le de nouveau.

Audacity Preferences
udio T/0 | Quclity | File Formats | Spectrograns | Directories | Interface | Keyboard| 41 *

Playbaclk

Davica: |Inud speaker Hizgh Definition Audio ) ﬂ
e

Device: |micmphone (USE dudio CODEC ) j
Channels: |2 (Sterea) j

|7 Flay other tracks while recording new one
[~ Software Flaythrough (Flay new track while recording it)

Beruzeil ||( 0K )i

3. Réglez les volumes d’entrée et de sortie

Volume de sortie Volume d’entrée

) T ﬁ B
-1.0 0L0 1.0 2.0

F 1 " . 1 " 1 .

REMARQUE : A cause de la variation des systémes d'exploitation, le controle du volume
d'entrée ne fontionne pas sur certaines versions de Windows individuels. I1 est recommandé de
télécharger une nouvelle version pour une meilleure compatibilité de la page d'accueil d'audacity:
http://audacity.sourceforge.net.

17



Prépar atifs pour exporter et sauvegarder lesfichiersen format MP3

Préparatifs en vue de |’ exportation en format MP3. (Il faut installer au préalable un logiciel
supplémentaire, soit « lame_enc.dll ».)

1. Assurez-vous que le disque d" Audacity est encore dans e lecteur de votre ordinateur.
2. Cliquez sur I'onglet « Edit » (Edition) de |’ interface d’ Audacity, puis sélectionnez
« Preferences » (Préférences)

alo]xl
[l |Edk Yew Project Generste Effect nalyte Help
I:l' UdoRecord iz L P
: ks n | L
EE ._).).// G W M A2 0 Py b M A2 0
< PL_ g * [steres =]
£ 5 2 2[2]5,
T L m 2030 2040 2050 2060 24010 2:08.0
o P
-
n
"} -
T, Seler... »
L ~
T Selection Save
—
sk space remains for recording 6 hours and 38 miutes
Projectrste: 44100 | |Cursor 202 376281 masec [Snap-To Off)

3. Sélectionnez I’ onglet « File Formats » (Formats de fichier), puis cliquez sur le bouton « Find
Library » (Chercher lalibrairie).

Audacity Preferences
udie 1/0 | Quality File Formats |Spectrograns | Bi ies | Interface | Keybourd| 4 »

r¥hen importing uncoapressed audio files into Audacity

- !Jh_l__csnu(_l.ha_h.h_b__d_ﬂu_dg_lm?_[iﬂsﬁll
& Read directly from the original file (Easter

rUnconpressed Export Format
[#AV Microsoft 16 bit PCM) =l

WAV Microsoft), Signed 16 bit PCH

~06G Export Setup
066 Quality: [ 5 O I

NF3 Export Setup

WP3 Library Version: LANE v3.96 Find I_.i'brary I

Bit Rate: |128 'I
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4. Une fenétre de dialogue s affiche alors. Cliquez sur « Y es » (Oui).

Export MP3 3 x|

Audacity does not export MP3 files directly, but instead uses the

T\  freely available LAME fibrary to handle MP3 file encoding. You must
obtain lame_enc.dll separately, by downloading the LAME MP3 encoder,and then locate
this file for Audacity. ‘You only need to do this once.

Would you like to locate lame_enc.dll now?

5. Une autre fenétre s' affiche; elle permet d'aller chercher lefichier requis sur le CD-ROM. Vous
y trouverez le logiciel « lame_enc.dll ». Cliquez sur le logiciel, puis sur le bouton Open (Ouvrir).

Where is lame_enc.dll? i ‘ﬂl(j

= @@dﬁ-

Desktop

4

My Documents

wr
- =
My Computer

My Network
Places
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6. Cliquez sur le bouton OK

Audacity Preferences

hudio I/0 | Quality File Formats ISput.ro;ru:I Dirsctories | Interface | Keybourd | Al

"nn importing uncempressed audio files into Audacity

" Maks s copy_of the £ils bafors sditing (zafar]]
(* Bead directly from the original file (faster)

~Unceapressed Export Format
[RAV Microsofr 18 bit PCM) =]

WAY Microsoft), Signed 16 bit PCM

~0GG Export Setup
066 Quality: [ 5 0 ); 10

~MP3 Export Setup

MF3 Library Version: LANE v3.96 Find Library |
Bit Hate: |I23 vI

Cancl | ke |

La configuration du logiciel MP3 est désormais terminée et vous pouvez commencer a exporter
des enregistrements dans le format MP3.
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Procédured’ enregistrement

Pour enregistrer lamusique sur votre ordinateur :

1. Mettez le disgue sur |e tourne-disque.

2. Déplacer le bras de lecture sur le vinyle pour commencer ajouer.

3. Cliquez sur latouche d enregistrement () pour commencer |’ enregistrement. Les ondes
(supérieures et inférieures) apparaitront dans I’ interface.

4. A lafin delachanson, cliquez sur latouche de pause (i) soulevez et déplacez le bras de lecture &
Son appui. Pour enregistrer la chanson suivante, changez le disque ou déplacez | e bras de lecture
jusou’ &la chanson voulue. Appuyez immédiatement sur le bouton de pause (ir) de !’ ordinateur;

I” enregistrement se poursuit alors.
5. Répétez |es étapes 3 et 4 jusqu'a ce que vous avez terminé le tél échargement.

REMARQUE : Necliquez pas sur le bouton d’ « arrét » sur I’ ordinateur lorsque vous enregistrez
continuellement des chansons. Souvenez-vous de cliquer sur e bouton de « pause » entre les
chansons. N’ appuyez sur le bouton d’ « arrét » de I’ ordinateur que lorsque vous avez terminé

I” enregistrement de toutes les chansons souhaitées.

Lorsque vous avez terminé d'enregistrer les chansons, vous pouvez les jouer sur votre
ordinateur. En mode d' arrét, cliquez tout simplement sur la touche de Iecture@

NOTE : Vous ne pouvez pas écouter |a musique pendant le processus de |'enregistrement.

=181 x|
Ele Edt Yew Project Generate Effect Anshyze Help

B2 ) (a w) @) ) [
P e %k J_/* jj) A b 4 20 P b M 120
4) et Pl g Y [stereo =] [
[¢ [m[@[ww] -] p[o[L]R]

0 240

210 22 230 250 26.0 27.0 280 29.0 .

x| Audio Track w | 1.0 -

Stereo, 44100Hz 05

32-bit float il

R et

; ; Vi v\\

& A0 ~

10
e Onde fluctuante
. /-
o P R TS 4
05
1.0

ﬂ »
|Dksk space remains for recording € hours and 2 minutes
Project rate: 44100 | [Cursor: 0:00.000000 mincsec [Snap-To Off]
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Probléme général pour toutesles versions de Windows

1. Lorsgue la platine est connectée, vous ne pouvez pas entendre le son si vous avez besoin
d’ écouter lavidéo ou lamusique. |1 est parce que le périphérique de lecture par défaut a été
changé {)USB Audio CODEC une fois que |e tourne-disgue se connecte au PC.

Solution préférée:
Retirez simplement le cable USB du PC.

Solution alternative:
Si vous choisissez cette solution, vous devez modifier le réglage manuellement a chaque fois que
vous connectez le cable USB avec le PC.

Vistaand Windows 7:

Cliquez sur "Démarrer" et allez dans le Panneau de configuration. Trouvez et cliquez sur I’ icdne
"Son". Cliquez sur |’ongle touche "Lecture" et modifier le périphérique de lecture. Cliquez OK.
(Veuillez seréférer aux figures ci-dessous).

'ﬁ Sound g‘

Playback | Recording | Sounds | ations |

Select a playback device below to modify its settings:

Speakers
High Definition Audio Device
Ready

o Digital Audio (5/PDIF)

m Speakers
& Read:

|: Set Default !V] l Properties .

ok ][ concel ]
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AutresVersions(e.g: Windows Xp)

21

mnmj
i~ Sound playback

@ Default device:
' [Microphone USB Audio Codec =]

i~ Sound recording
/éi Defaul device:
4 [Micronhone USB Audio Codec =]

[~ MIDI music playback
Default device:
e |Micnosoft GS Wavetable SW Synth j

[T Use only default devices

e Vouspouvez cliquer sur "Démarrer" et trouver des"Programmes’, "Accessoires’,
"Divertissement: et cliquez sur " Magnétophone". Ensuite, dans e Magnétophone, cliquez
sur I’onglet "Edition" et sélectionnez "Propriétés Audio". Ou, trouvez et cliquez sur Panneau
de configuration. Recherchez et sélectionnez «Sons et périphériques audio» et Choisissez
onglet "Audio".

e Dans Lecture audio, changez le périphérique par défaut en tirant la fléche. Sélectionnez votre
périphérique de lecture et cliquez sur OK.

e Puisle son commengera ajouer.
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2. Si vous voulez entendre la musique pendant |e téléchargement sur |'ordinateur, Suivez
les étapes ci-dessous :

Allez sur L'Interface d’ Audacity

Cliguez Edit, puis sélectionnez "Preference”. Puis cliquez sur I’ onglet "Audio | / O".

Et suivez le réglage suivant. Cliquez sur "OK" pour confirmer

Décochez la case pour désactiver lafonction

Audacity Preferences
Audio I/0) Quality | File Formats | Spactrograms | Directories | Interface | Keyboard | 4| *]

Playback
Device: |loud speaker MHigh Definition Audio ) |
Recording
Device: |microphone (USE Audio CODEC ) =]
Channels: ]2 (Stereo) LI

ay other tracks while recording new one
oftware Playthrough (Play new track while recording it)

paca | [Cor )]
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Réglages pour Windows 7, et du systéme Vista uniquement.

Si vous N’ avez pas la vague fluctuante sur I'interface d'’Audacity ou le son est perturbé
pendant I’ enregistrement, réglez e niveau d'enregistrement comme suivante:

e Cliquez sur "Démarrer" et allez dans le Panneau de configuration.

Connect To

Default Programs

Help and Support

All Programs

Y Untitled - Paint

e Danslavue classique, double-cliquez sur I'icone Son.

(===
() [E » controlPanel + [+ ] [ search 2]
Name Categer -
Cantrol Panel Home gty
= Classic View ) (- - N3
© /¥ mE g P
Offline Files Pen and People Near Performance Personaliz.. Phone and Power
Input Devices  Me  Informatio.. Modem ..  Options
: =1 =
7 P K “..J 5 = |
= 13 e =
Printers  Problem  Programs  QuickTime Regional and Scannersand  Security -
Reports a... and Features Language ... Cameras Center
4 "~ ]
1 N Y -
q\r '&‘I g i =
Speech  SyncCenter  System Tablet PC  Taskbarand  Textto
Recogniti... Settings  StartMenu  Speech
: — ==l - - . @ )
L s
= =
User Welcome  Windows  Windows  Windows  Windows  Windows
Accounts  Center  CardSpace  Defender  Firewall  Sidebar..  SideShow
&
&P " ]i;
-
Windows a2t L4
Update -
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e Ou dansle Panneau de configuration Home vue, cliquez sur « Matériel et audio ». Puis
cliquez sur « son ».

HE [ 2]

System and Maintenance User Accounts
Get started with Windows 1 Change account type

Back up your computer

Security
Check for updates

Appearance and
Personalization

Change desktop background
Change the color scheme
Adjust screen resolution

Allew @ pregrem through Windows
Firewall

Change keyboards or other input
methods
Change display language

Hardware and Sound
Play CDs or other media autormsaticlly
Printer

Ease of Access
Let Windows suggest settings
Optimize visual display

Mouse

. Network and Internet 5
View retviork status and tasks & Clack, Language, and Region

Programs o .
m Uninstall 2 program Additional Options

Change startup programs

- | +5 H Search

Printers
Add a printer | Change default printer | Remove a printer | Send a fax

AutoPlay

Change default settings for media or devices | Play CDs or other media automatically

grams

r Accounts em volume | Change system sounds | Manage audio devices
Appearance and
Personalization Mouse

Clock, Language, and Region Change button settings | Change pointer appearance

Ease of Acc - i
Additional Options \@ Rower Options

Change power-saving settings | Change what the power buttens do
Require a password when the computer wakes | Change when the computer sleeps
Classic View
Personalization
Change size of on-screen items | Adjust screen reselution
How to correct monitor flicker (refresh rate)

&= Scanners and Cameras
B yiew scanners and camerss | Scan a document or picture

<> Keyboard
Change cursor blink rate | Check keyboard status
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e Dansl'interface Son, sélectionnez |’ onglet « Enregistrement ».

Select a recording device below to madify its settings:

" 4 Micraphane
High Definition Audio Device
Mot plugged in

" 4 Mierophone
High Definition Audio Device

“"{9 Not plugged in

Line In
o High Definition Audio Device

d p{' Microphone

W, USB Audio CODEC
N Working

ok ][ cancl [ oo

e Ensuite choisissez un périphérique d enregistrement. I ci, nous vous recommandons de

sélectionner microphones de I'USB Audio CODEC qui est surlignée dans I'image et cliquez sur
« Propriétés ».
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e Séectionnez les niveaux de volume. Les niveaux sont a partir de 0 a 100. Normalement, ils
devraient étre 3-8. Toutefois, vous pouvez se référer al'indicateur de niveau d'entrée a partir du
panneau Audacity qui n’excede pas 0. Cliquez "OK" sur I'interface propriétés du Microphone et sur
I'interface du Son. Fermez |e Panneau de configuration. (Veuillez noter qu'il n'y apas d’ onglet
"niveaux" dansle panneau du "Son" dans certains systémes d'expl oitation, comme Windows 98,
Windows 2000. Pour les utilisateurs de Windows 7 et Vista, I’ onglet "niveaux" est disponible dansle
panneau du "Son").

.
:-‘ Microphone Properties u

| General | Cusborr([ Levels |)dvanced|

>

Q/mo@

Microphone

(OK J Cancel Apply
Indicateur de niveau

d'entrée
B Audacity
File Edit View Project Generate Effect Analyze Help 14

- - (B e %
Ti=1s F TN Ty ., pL...... .
: W) r)le n) m) w) |F—TELRE—L]
;p‘n % ' by S im i g ;W‘%‘%‘W—M—M ﬂfj }9‘}9‘8‘8‘
71‘.0 Q.O | 1‘.0 2|.0 3‘.0 4‘.0 5‘.0 .'0 7‘.0 Q.O 2.0 1Q.0
X|Audio Track ¥ | 1.0
Stereo, 44100Hz. 05
32-bit float -
e | Son | | o0
“““““ |10
1.
05
0.5
1.0
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Division des pistes

Lorsgue I enregistrement est terminé

1. Appuyez sur le bouton @ pour revenir au début de la toute premiére chanson.

Par exemple : Vous avez enregistré deux chansons. La premiere chanson dure de 0:00 a 1:45; la
deuxiéme chanson dure de 1:45 a4:00.

2. Déplacez le curseur vers la zone d’ affichage de la forme d' onde, puis cliquez sur le bouton
gauche de la souris, maintenez et trainez le curseur pour sélectionner votre zone désirée.

=lolx

DO s |

1l ol . 1 o0

|iak space remains for recording 11 hours and 35 minutes
Projectroe: 4100 | [¢ ATATTE . 147 00678 |Snap-To o) |

m—— e [ i ——

3. Cliquez sur I'onglet « File » (Fichier), puis sélectionnez une forme al'exportation :
« Exporter la sélection en WAV » « Exporter la sélection en Ogg», ou « Exporter la sélection

en MP3»

4. Une fenétre de dialogue s ouvre pour vous permettre de spécifier le titre de la chanson (« File
name » [Nom de fichier]) et sélectionnez une exportation ("Sauvegardez sous"), et aussi vous pouvez
également sélectionner e format du fichier (« Save astype » [Type]).

5. Cliquez sur « Save » (Sauvegarder) et la premiére chanson sera sauvegardée sur votre
ordinateur.
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Prenez "Exporter au format WAV", par exemple:

Save WAV (Microsoft) File As:

Save inc [QDekktuo j « &k
‘_‘b {C3My Documents
: '8 My Computer

My Recent &by Network Places
Documents

=

Deskiop
My Documents
My Computer
My Network  File pame: Sp - Save
y pame: [sping =l x|
Saveaslype:  [WAV [Microsoft)files [".wav) = Cancel

Diviser et exporter la deuxiéme chanson:

1. Déplacer le curseur pour surligner votre deuxiéme chanson.

M 8

12 &0

T = 9 VY [Emen
T T L e . B . R L A5 300 318 s
e
Werws_ 441000
Mie  Sels o0
L o L ]
9 A0
1
0s
Y
a5
a0
e v | 10
Theren, A4100M2 o8
e fout
| B0l gp
=]
a5
L 0 " =
10
0% 1
00

-

Chek el g o e g e by
Troecirse S0000 | Gewcion 165 $43040 - 400 TIE0E (21510008 mevvec) [Srae-To O}

2. Suivez les étapes 3, 4 et 5 (ci-dessus) pour diviser les chansons, une a une.
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Exporter et sauvegarder desfichiersen format WAV, Ogg ou M p3 (unefoisque
I’ enregistrement est terminé)

e Lorsque lachanson est terminée, cliquez sur le bouton @ sur lelogiciel. Appuyez ensuite
sur le bouton d’ ARRET sur |e tourne-disque.

e Lamusique est désormais enregistrée sur votre ordinateur. La musique doit toutefois encore
étre transformée en fichier format WAV, Ogg ou MP3 avant de |’ exporter.

e Vous pouvez jouer lamusique par votre ordinateur. Cliquez simplement sur le bouton ()

pour jouer I’ enregistrement.
Pour des informations plus détaillées et opération, vous pouvez visiter le site Web d’ Audacity a
http://audacity.source forge.net et recherchez, puis cliquez sur « Aide », « Contactez-nous »

1. Cliquez sur I'onglet « File » (Fichier) dans|’ Interface Audacity. Sélectionnez « Export as
WAV » (Exporter en WAV), « Export as MP3 » (Exporter en MP3) ou « Export as Ogg »
(Exporter en Ogg).

Exporter en format WAV

IE!;& Yew Project Generste Effegt Anahze Help

[T QrHN

Cpen... O n W
Close W

Save Project ks T 50 6.0

Save Froject fs...

Recert Files...

Export As Ogg Vorbis....

Export Multiple. ..

Page Sehp...
Print...

Ext i LU i Ll il o

Exporter en format Ogg

Em Yo Broject Generste Effect Anahvae Help

biew Qe

Opan... Qb n L

Chose Crrie

Save Propect arks T 50 6.0

Save Project Bs... e —
Recent Fles.. »

Expnt As WAY. ..

Export As MP3..

[T eoatasomvortis,, | i L L L b o

Export Mukiple....

Page Setup...
Frie.

Exit B L BLAR i el bl ] s

2. Lorsgue vous aurez choisi le format dans lequel I'enregistrement sera exporté, la fenétre
suivante s affiche. Elle vous permet d’indiquer le nom du fichier et I’endroit ou il sera
sauvegardé (par exemple, le bureau). Cliquez ensuite sur « Save » (Sauvegarder).
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Sauvegarder en format WAV

Save WAV (Microsoft) File As:

Savein: | [} Desktop =] « Bk
L;b ."'_leDowms
! 4 My Computer

My Recent Network Plac
Documents ‘ﬂﬂr =

=

Save as type: |WAV [Microsoft] files [* wav)

Deskiop
Myl:‘!m.lms
&
My Computes
My Network.  File Spri b
yF'Im e | ping J Save _}.I
- Cancel I

Sauvegarder en format Ogg

Save 0OGG File fs:

Save jn: I[B Deskiop j - B I:*E.!'

st" 3 My Computer
My Recent &My Network Places
Documents

€]

Desktop

My Documents

My Computes

"yP':a::'k File pame: Eoir] =l | Save L3 I
Save a3 lype: | DG files *.09g) =l Cancel
=

Suivez les mémes étapes comme ci-dessus pour " Sauvegarder en format MP3".
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POUR INDIQUER LE TITRE DE CHANSONS SUPPLEMENTAIRES (format MP3
uniguement)

Pendant I" exportation de la sélection en format MP3, lelogiciel vous offre une seuleoccasion
d'indiquer le titre de la chanson sauvegardée. Toutes les chansons que vous sauvegardez par la suite en
divisant le méme enregistrement auront le méme titre. Pour remédier a cela et donner destitres
individuels aux chansons, observez la procédure suivante :

1. Cliquez adroite sur le fichier de musique pour afficher son contenu.

2. Sélectionnez « Properties » (Propriétés), puis cliquez sur « Summary » (Résumé).

3. Cliquez sur « Title » (Titre), et saisissez le titre que vous souhaitez.
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Configuration d’Audacity pour Mac

Attention aux utilisateurs de MAC!

Si vous avez des problémes avec votre logiciel qui ne fonctionne pas correctement, veuillez visiter
notre site web pour télécharger la derniére version du logiciel.
http://ithomeproducts.com/support

Interface d’ Audacity pour Mac

- Project Rate (12); Salection Start: @ End Length  Audio Position:

W @ Oseue e TOROOmODET

Interface d’Audacity Interface — Paramétres et commandes.

Vous trouverez les réglages de volume d’entrée et de sortie dans la partie supérieure de la fenétre
principale d’ Audacity, a droite des indicateurs de niveau sonore d’entrée et de sortie (qui portent
les étiquettes « L » [G] et « R » [D]). Sous I’indicateur de niveau sonore de sortie, vous trouverez
une icone en forme de microphone et a coté de celle-ci une fléche vers le bas. Cliquez sur cette
fleche, puis sélectionnez « Start Monitoring » (Démarrer le contrdle en continu). (Si les
indicateurs de niveau sonore d’entrée et de sortie ne sont pas visibles, ouvrez la fenétre des
préférences comme cela est décrit plus haut.)

VD NENIDN| & M ——
S d) w| -18 -ao)_,,. -18
bl

Horizontal Stereo
Vertical Stereo

Preferences...
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Boutons de commande d’ Audacity

Utilisez les boutons de commande en haut de I écran pour aller au début du fichier, pour jouer,
enregistrer, faire une pause, arréter et terminer. Utilisez les menus File (Fichier), Edit (Edition),
View (Affichage), Project (Projet), Generate (Générer), Effect (Effet) et Analyze (Analyse) pour
sauvegarder, exporter et éditer lamusique.

1. Cliquez sur le bouton E pour aler au tout début;

2. Cliguez sur le bouton E] pour jouer |’ enregistrement;

3. Cliquez sur le bouton [E] pour enregistrer;

4. Cliquez sur le bouton E pour faire une pause lors de |’ enregistrement;

5. Cliquez sur le bouton E] pour arréter |’ enregistrement;

6. Cliquez sur le bouton E] pour aller alafin del’ enregistrement;

7. Réglez levolume du signal de sortie.

8. Réglez le volume du signal d' entrée.

1) (2) (3) (4) (B) (6 i, 8
®  Audacity |File | Edit v.l Transgort Tracks Generate Effect Analyze Window Help - D 3
| I I Audacity (L
|__rsl ’ @ n b d . T :‘: . —— 94 2
Plo x| v it 60 ol -t 60|y o @ |t oo | B s s
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Préférences d’Audacity

Cliquez sur « Audacity » dans |’ interface d’ Audacity, puis sélectionnez « Preferences »
(Préférences).

Services

Hide Audacity &H
Hide Others "C3H
Show All

Quit Audacity #Q

Lafenétre des préférences d’ Audacity s afficheraal’ écran. Vous verrez les onglets « Audio
1/0 » (E/S audio), « Quality » (Qualité), « Import/Export » (Importation/Exportation),

« Interface » (Interface), « Spectrograms » (Spectogrammes), « Directories » (Répertoires),

« Smart Recording » (Enregistrement intelligent), « Theme » (Théme), « Keyboard » (Clavier)
et « Mouse » (Souris).

(ﬂ%

Audio 1/0 Playback Recoring

Quality Device: [ Core Audio: Built-in Output ) Device: [ Core Audio: US8 Audio CODEC i+
Import [ Export M

Intesface Using: Portaudio vi9 Channels: | 2 terea)
Spectrograms

Directories MM

Smart Recordin ) Overdub: Play other tracks while recording new one

b i " Hardware Playthrough: Play new track while recording it

g ¥ Software Playthrough: Play new track while recording it

[ffects Preview Cut Preview

Length of preview: 3 seconds Preview before cut region: 1 seconds
Preview after cut region: 1 seconds
Latency Seek Time when playing
Audio to buffer: 100 | Shart period: 1 | seconds
(higher = more latency) milkiseconds T
Latency correction: § LN LT

{negative = backwards) R

(am) G5
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Sélectionnez |e périphérique d' enregistrement « Core Audio (USB Audio CODEC) »

e Cliguez sur I’onglet « Audio I/0 » (E/S audio) dans lafenétre des préférences d’ Audacity.

e Cliquez sur « Device » (Périphérique) et sélectionnez « Core Audio (USB Audio CODEC) ».
¢ Cliguez sur « Channels » (Canaux) et sélectionnez « 2 (stereo) ».

e Cliquez sur « OK ».

REMARQUE : Si « Core Audio (USB Audio CODEC) » nefigure pas danslaliste de
périphériques, fermez le logiciel Audacity, puislancez-le de nouveay, et vérifiez quele
tourne-disque est effectivement branché sur I’ ordinateur..

[eTe"s’ udchy Prefecences
Audio 1/0 b Recerding
Qualiey Device: CCore Audio: Built-in Output C Device: (Core Audio: USB Audio CODEC -
Import | Export o - 2
Interface Using: Portaudio v13 Channels: | 2 (Stereo) 2]
Spectrograms
Directories Hoytheeugh
Smart Recording () Overdub: Play other tracks while recording new one
Theme () Hardware Playthrough: Play new track while recording it
:""mam ™ Software Playthrough: Play new track while recording it
ouse
Effects Preview Cut Preview
Length of preview: 3 " seconds Preview before cut region: 1 | seconds
Preview after cut region: 1 seconds
Latency Seek Time when playing

thigher ‘:“:":r:"l:::'::, 100 milliseconds Short period: |1 seconds
L Long period: 15 seconds

Latency correction: 0

(negative = backwards) R

(Cancel )

Dans|’onglet « Quality » (Qualité), réglez |e paramétre « Default Sample Format » (Format
d' échantillonnage par défaut) sur « 16-bit ». Sélectionnez OK pour sauvegarder vos réglages,
puis fermez la fenétre des préférences.

00 Audacity Preferences
Audi | Sampling
¢ Default Sample Rate: | 44100 Hz 44100
Impert [ Export -
Interface Default Sample For
24-bit
Spect:
ok Conversion 32-bit floar
Directories A r
Smart Recording Sample Rate Converter Dither
Thame Real-time: | Fast Sinc lation 4] [ None |
Keyboard -
Mouse High-quality: | High-quality Sinc In... a Triangle $|

f: Cancel ) @
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Réglage de ’enregistrement intelligent

1. Sélectionnez I’onglet « Smart Recording » (Enregistrement intelligent) dans la fenétre des
préférences d’ Audacity et réglez le paramétre « Sound Activation Level(dB) » (Niveau sonore
d’activation en dB) a « -36 », puis cliquez sur OK.

Audacity Preferences

Audio 1/0 Sound Activated Recording

Quality
™ Sound Activated Recording
Import / Export

Interface _F=r
Sound Activation Level (dB):
-36

Spectrograms
Directories
Smart Recording
Theme

Keyboard
Mouse

-36 0

(" Cancel ) l‘m)

2. Vous trouverez les réglages de volume d’entrée et de sortie dans la partie supérieure de la
fenétre principale d’ Audacity, a droite des indicateurs de niveau sonore d’entrée et de sortie (qui
portent les étiquettes « L » [G] et « R » [D]). Une icone de volume se trouve a gauche des
réglages de volume. Pour régler les volumes d’entrée et de sortie au maximum.

Volume de sortie Volume d’entrée

Window Help 9 3%

Audacity
2

Y

¢ [ma| @[t jun] [o]] I |,

=

REMARQUE : A cause de la variation des systémes d'exploitation, le contréle du volume
d'entrée ne fontionne pas sur certaines versions de Windows individuels. Il est recommandé de
télécharger une nouvelle version pour une meilleure compatibilité de la page d'accueil d'audacity:
http://audacity.sourceforge.net.
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Exporter et sauvegarder desfichiers(une fois que I’ enregistrement est terminé)

e Lorsque lachanson est terminée, cliquez sur le bouton El sur lelogiciel. Appuyez ensuite
sur le bouton d” ARRET sur le tourne-disque.

Lamusique est désormais enregistrée sur votre ordinateur.

e Vous pouvez jouer la musique par votre ordinateur. Cliquez simplement sur le bouton [>]
pour jouer I’ enregistrement.

e Pour desinformations plus détaill ées et opération, vous pouvez visiter e site Web
d’'Audacity a

http://audacity.source forge.net et recherchez, puis cliquez sur « Aide », « Contactez-nous »

1. Cliquez sur I’onglet « File » (Fichiers) de |’ interface d’ Audacity, puis sélectionnez « Export »
(Exportation) pour sauvegarder le fichier.

® Audacity m Edit View Transport Tracks |

P00 New 2N

gm_z.a FIE Open... %0

: B | | Open Recent >

L e k| !
=5 Close £
it . Save Project )

X[Audio Trac w[ 1. Save Project As...
Stereo, 44100Hz | 0!  Saye Compressed Copy of Project...

LORDRECH o4 Check Dependencies...
Mute [ Solo 7

g -0.! Open Metadata Editor...

L R I 1
Linn@eiini gy Import 4
g “bgort..
04 Export Selection...
=04 Export Labels...
= “L Export Multiple...
Export MIDI...
Apply Chain...
Edit Chains...
Page Setup...
Print...

2. Lafenétre ci-dessous s ouvrira alors. Par défaut, le format de sauvegarde est « MP3 », mais
vous pouvez choisir un autre format en cliquant tout simplement sur le fléche adroite de
«MP3 Files ».

Audachy
Save As: lspring| I E] I
Where: | (& Desktop F%i
Format:| MP3 Files I—'rq ( Options... )

Cancel
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Guide de dépannage

Si I"appareil ne fonctionne pas convenablement, veuillez essayer de résoudre le probléme vous-
méme en observant les directives suivantes avant de communiquer avec votre distributeur.

AUCUN SON :

e Silelogiciel n'enregistre aucun son, retournez alafenétre des préférences tel qu’indiqué
ci-haut et assurez-vous d’ avoir sélectionné le périphérique d enregistrement a Entrée USB.

e FEteignez puisralumez I’ appareil : Fermez Audacity, éteignez le tourne-disque, débranchez le
cable USB, puisrebranchez le cable USB, allumez | e tourne-disgue et redémarrez Audacity.

e Si vous n'entendez aucun son lorsgue vous jouez un disque, cliquez sur le menu déroulant du
microphone et sélectionnez « Monitor Input » (Contréle du signal d’ entrée). Celavous

permettra d’ écouter le son qui provient du tourne-disque méme si vous ne |’ enregistrez pas au
moyen du logiciel Audacity.

| L]
R 3
lh)El 48 -42 36 -30 24 .18 12 -6 0 ,ﬁlil A8 -42 36 -30 4
T [ @] o] A

4.0 3.0 6.0 7.0

Vertical Stereo

Linear

Disable

¢ Si le curseur du microphone n' est pas affiché, allez au menu des préférences d’ Audacity,
cliquez sur I’ onglet I nterface et vérifiez que les options « Enable Mixer Toolbar » (Afficher la
barre d outils de mixage » et « Enable Meter Toolbar » (Afficher labarre d outils des
indicateurs de niveau sonore) sont cochées. Dans le cas contraire, cochez-les, puis cliquez sur
OK.

e Vérifiez quele curseur du microphone est réglé sur le volume maximal, ¢’ est-a-dire
complétement adroite tel qu'illustré ci-dessous. Si le curseur du microphone n’ apparait pas a
|" écran, allez au menu des préférences d’' Audacity, cliquez sur I’ onglet Interface et vérifiez que
les options « Enable Mixer Toolbar » (Afficher labarre d’ outils de mixage » et « Enable Meter
Toolbar » (Afficher labarre d outils des indicateurs de niveau sonore) sont cochées. Dans le
cas contraire, cochez-les, puis cliquez sur OK.

gror —5>
0 : 10—

o

40



Son de mauvaise qualité:

¢ Vérifiez que lacartouche est convenablement connectée au bras de lecture. La cartouche doit
toujours étre connectée au bras de lecture lorsgque vous utilisez le tourne-disque.

¢ Vérifiez que vos prises RCA sont branchées sur une source ou gu’ elles ne touchent pas un
morceau de métal nu. Si vous captez des parasites par I'intermédiaire du port USB, il se peut
qu'ils proviennent des fiches RCA. Evitez tout contact ou rapprochement entre le cable USB et
un autre céble.

¢ Si votre enregistrement contient des sons bizarres, fermez tous les programmes, redémarrez
votre ordinateur et essayez de nouveau d’ enregistrer en n’ exécutant que le logiciel Audacity.

e Veillez ainstaller et régler convenablement le bras de lecture du tourne-disque.

Caractéristiques techniques

PHONOGRAPHE
MOLEUF ... Servomoteur CC
Entrainement .........cccceeveeeenenese e Courroie
VIESSES .ttt 33-1/3 tr/min, 45 tr/min et 78 tr/min
Pleurage et scintillement .........ccccooveeineincnecnene Inférieur 20,25 % (WTD)
Rapport signal sur bruit ...........ccocceveinenneinencnnn. Supérieur 450 dB
Type de cartouche .......ccovev e, Cartouche stéréo céramique
PoiNte de [eCIUre.........oov e 402-M208-165
NIVEAU dE SOMIE.....veveeei et 160-380 mV (5 cm/sec a1 KHz)
GENERAL
Alimentation reqUISe.........ccovvvviie e e e e 120 VCA ~60 Hz
CONSOMIMEALTION. .. ... e e v 5w
DIimensions (L X H X P).c..cccveeiiiieniireneee e 34.8cmL x10.8cmH x 34.7cm
POIS......coieieieee e 5,55 Lbs (approx)
ACCESSOIreS Standard..........cooevererereenresece e Manuel d' Instruction
Adaptateur 45 Tours
CD (Pilote avec Logiciel Audacity)
CébleUSB
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AVERTISSEMENT : Ce produit contient des substances chimiques connus au |'état de
Californie pour provoquer des défaut de naissance ou autres dommages reproductifs. Pour avoir
plus de renseignements sur ces réglements et une liste des produits chimiques, connectez-vous sur
le site suivantes : http://www.oehha.ca.gov/prop65.htm

CALIFORNIA PROP 65 WARNING

Innovative Technology Electronics Corp.
Garantielimitée: 90 jourspour la main-d’oeuvre, un an pour lespiéces

Innovative Technology Electronics Corp. (IT) garantit que ce produit est exempt de « défaut » de

piéces dans des conditions normales d’ utilisation pendant une période de « un an » a partir dela

date d’ achat original. La garantie n’ est pas transférable. IT consent, durant la période initiale de «

90 jours », aréparer « sans frais» le produit si celui-ci est jugé défectueux. IT consent de plus a

acquitter les frais de réparation ou de remplacement des « piéces » endommagées pendant une

période de « un an » a partir de la date d’ achat original. La garantie ne couvre pas les dommages
cosmétiques, les antennes, les cordons c.a., les boitiers, les bandeaux, les cache-oreilles, ou les

dommages causés par les sautes de puissance, le raccordement a une source d alimentation ou a des
réglages inadéquats, |’ usage impropre, la manipulation inappropriée, un accident, une catastrophe naturelle
ou une tentative de réparation par un prestataire de service non agréé. Pour obtenir des prestations de
service, |’ acheteur original DOIT soumettre un coupon de caisse/ une preuve d' achat indiquant la date

d achat, e montant payé, et le nom du magasin. Expédiez I’ appareil, port payé, al’ adresse ci-dessous, dans
son emballage original ou autre emballage semblable pour éviter d’ endommager I’ appareil. Vous devez
indiquer votre nom, adresse d' expédition et numéro de téléphone. Aucun retour ne sera expédié a une case
postale. Veuillez joindre un chéque ou mandatposte de 12 $ al’ ordre de Innovative Technology Electronics
Corp. pour acquitter lesfrais

de manutention et de retour. (IT) n’ est pas responsable des délais ou des réclamations non traitées

si I"acheteur ne fournit pas tous les renseignements nécessaires.

Pour toutes questions ou retours, veuillez écrire a:
Customer Service Dept.

Innovative Technology Electronics Corp

1 Channel Drive, Port Washington, NY 11050
TOLL FREE# 1-877-ITECH-97 (1-877-483-2497)
Site web: www.ithomeproducts.com

EMAIL: support@ithomeproducts.com

Il N’ existe aucune garantie expresse, sauf celle qui est indiquée ci-dessus.

TOUTE REPARATION OU ECHANGE EN VERTU DE CETTE GARANTIE CONSTITUE
LE RECOURS EXCLUSIF DU CLIENT. (IT) N'EST PAS RESPONSABLE DES
DOMMAGES INDIRECTS OU ACCESSOIRES A CE PRODUIT EN CAS DE RUPTURE DE
GARANTIE EXPRESSE OU TACITE, SAUF DANSLE CASOU LA LOI APPLICABLE
L’INTERDIT. TOUTE GARANTIE TACITE DE QUALITE MARCHANDE OU D’ APTITUDE
A UN USAGE PARTICULIER RELATIVE A CE PRODUIT SE LIMITE A LA DUREE DE
CETTE GARANTIE.

Certaines provinces interdisent |’ exclusion ou la limitation des dommages indirects ou
accessoires, ou les limitations concernant la durée de la garantie tacite. 1l se peut donc que les
exclusions ou limitations susmentionnées ne s appliquent pas a vous. Cette garantie vous confére
des droits |égaux particuliers, et vous pourriez jouir d autres droits selon votre province de
résidence.
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